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Hardware Guide



Turn On Sequence
off-reverse order

PC (let boot to windows)

Power Strip (microscope/light sources)-under microscope table on right
Lasers-key switch (clockwise)

C2 Confocal Controller-push button on front, middle

Launch Software

abkowbE

*Incubator touchpad if required



Main System Components



Ti-E Microscope Confocal PMTs

Confocal
Controller

Scan Head
CCD Camera _ _
Joystick (twist top to 6

adjust speed)



Lasers

« Key switch should be in “OFF” when not in use,
and switched “ON” before starting the controller



Controllers and Power Supplies

Color Camera Controller

On/Off for Fluorescence

transmitted light
(brightfield) Supply

Rheostat for
transmitted light

Both controllers are e——

operated manually or

through NIS-Elements
(EPI/DIA shutters).
Each has a rheostat

for adjusting intensity.

Stage Power Supply 8



Microscope: Nikon Ti-E




Display: Resets
Brightness Current Z
Adjustment and position
Display Info to Zero
e Perfect Focus
eony - 0EE S Adjustments
Light Path:

-
Eye-Eyepiece
Viewing

L100-Confocal |
R100-CCD Camera
L80-NOT USED

Magnification Changer: 1x or 1.5x
10
*Please default to 1x



Z focus adjustment

Focus Knob

Left Side

Rheostat for
transmitted light

Objective Adjustment-
will rotate to next
objective lens

On/Off for
transmitted light
(brightfield)
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Right Side

Z focus adjustment

N/A : \//

Coarse @
Fine @

ExFine @ /
°‘ ; ‘ i Focus Knob

Epi t—‘,ihuﬁi‘l 'E'

i Filter L
l position
|

]
‘

Escape-lowers
objective

Refocus-raises
objective back up

1

*When “escaped

focus is disabled
12



/L

Top Sliders

\

*Push all sliders in the light path as
default

You currently have four filter positions:
Left: D (Diffuser)

Left: PFS (Perfect Focus)

Right: NCB (Neutral Color Balance)

Right: GIF (Green Interference-
currently empty)

13



Transmitted Light Adjustments

Field Diaphragm
for adjusting
Kohler Alignment

Polarizer-push in
for DIC and rotate &
for shading

Condenser
Height-set at
arrows

. Centering
Screws for
adjusting
Kohler
Alignment

Condenser Prisms-

manually controlled by hand

14



Quick Review on Kohler
Alignment

*Use a 10x objective (if available) and put the
condenser in the A position

1. Focus on asample (G

3. Focus your condenser (adjust condenser height) §&

5. Open field diaphragm (B

15




C

( --7%.;}

Your Objective Lenses

Nikon
Plan Fluor
(1) Magnification 100 %/ 1.20 @ Type of Immersion Liquid
(") Application Markings — DIC H2
(B) Cover Glass Thickness - oren W am {3) Warking Distance
1) Gollor Cods immersion Objective Identifier
{5) Retraction Stopper
(B) Immersion Oil Cover Glass
10x Plan Fluor =5
*good for plastic bottom $i=x
dishes/plates/chambered slides 11t
*uses Ph1 condenser prism R g
10x Plan Apo
*good for coverslips
*uses DIC N1 condenser prism

20x Plan Apo VC -
*good for coverslips =
*uses DIC N2 condenser prism L

"l"E 'i. l
,-/

——

Nikon
Plan Apo
40 % i 098 — {2) Mumerical Aperture
DI M
L 11023 WD 8

{4) Correction Ring
11 14 17 A0

Parfocal Distance

e Working Distance

40x Plan Apo Lambda
*good for coverslips
*uses DIC N2 condenser prism

60x Plan Apo Lambda OIL
*good for coverslips
*uses DIC N2 condenser prism

100x Plan Apo Lambda OIL
*good for coverslips

16



Oko-Lab StageTop Incubation

\\\\\\

bold line

bold line

The Oko Touch has a side switch to turn on
the incubation system. All components are
connected to this panel (CO2 control,
Heating, etc).

You have a digital 2-gas mixer which
requires 100% CO2 and Air (with the
supplied air pump) and will regulate the input
of CO2 to 5%.

You also have a heated, humidification
chamber; distilled water should be kept level
at the shoulder for operation.

You currently have inserts for the following
configurations:

* 96 Well Plate

 35mm Dish (2)

* Chambered Coverglass (2)
* Chambered Slide (2)

*These are magnetic and easily

interchangeable
17



Perfect Focus System

Perfect Focus OFF  «  Focus Maintenance System (not autofocus!)

870nm LED incorporated with offset lens and
line CCD for closed-loop detection

Beitiit Eodiie O Critical for timelapse imaging

(no autofocus needed)
---- Can also be used for image stitching (tiling) and
high content well plate scanning

O amm Considerations: If oil lens is used, sample must be within
high of 3mm (height) of liquid above coverslip
liquid
Perfect Focus with an OIL Objective Perfect Focus with a DRY Objective

Perfect Focus Unit Operation / Perfect Focus Unit Operation /
ecimen low Specimen Windo

Finds Finds
top of bottom
cover of

slip coverslip

18




Perfect Focus System: Operation

1. Focus your sample to your eyes or monitor.

2. Turn on the PFS by pressing the “ON” button
located on the front of the microscope
(red arrow) or on the TiE pad in the NIS
Elements software.

3. You will hear the PFS system engage and the
“ON” button will become a solid green color.
*If blinking, adjust the focus knob until it locks
on to your sample

4. The image may go out of focus when the PFS
system engages-this is normal, as it finds your

coverslip top/bottom. Use the external PFS offset
controller to refocus the image (blue arrow).

Note: For safety, the focus knobs on the microscope

stand will not function while the PFS is in operation.
Coarse/Fine Focus

Moves PFS
prism in/out

of light path
19



Basic Operation

20



To use fluorescence to the eyepieces:

5 O

~ DISPLAY

MEMORY
PFS

Z-RESET

*Confirm you have turned on the system
in the correct sequence

1.

Place your sample on the stage and
choose an objective

*If oil is required, place a drop of oil on
the lens first before loading your slide or
dish

Select desired filter cube from the Ti
Pad or from the microscope on the
right side panel “FL Block”

Push Fluorescence controller to turn
on-adjust intensity as desired

Confirm lightpath is on “EYE” from Ti
Pad or from front panel on
microscope

21



To use briq htfield: 1. Place your sample on the stage and
choose an objective

2. On the right panel, rotate “FL Block” to
“DIA or empty” (for diascopic/brightfield)
or ANALY (for analyzer-for DIC)

- 3. Select a condenser prism; A (brightfield),
i~ FeE PH1 (for 10x Plan Fluor only),DIC N1 or
200 TR i N2 for DIC if applicable (selectable by

DISPLAY

- o= hand)

4. Turn on the diascopic light from the left
side of microscope and adjust the light as
needed

5. Select "EYE” from front panel

On/Off for .
transmitted light
(brightfield)

Condenser Prisms- Rheostat for
transmitted light
manually controlled by hand

*Note: to use a contrast method, you must match your
condenser prism to the appropriate objective; each
objective will have writing on the side to denote the 22
condenser prism to be used i.e. “20x, DIC N2”



Software Guide

23



Good to know.....

Most dialogs can be found under the View tab
(Acquisition/Analysis/Visualization Controls) in Elements

As a shortcut these can also be found by right clicking in
the back open space of Elements

Elements obeys most Windows-based functions,
shift/control and Alt are used often; right-clicks are used to
display options/properties

Elements also uses “drag and drop” for overlaying
windows/datasets

ND2 Files can be opened/viewed outside of Elements with
a free download on:
http://www.nikoninstruments.com/Products/Software/NIS-
Elements-Advanced-Research/NIS-Elements-Viewer.
There is also a plugin for ImageJ from:
http://rsb.info.nih.qov/ij/plugins/nd2-reader.html

24



General Software Statements

As a general reference, the devices connected to the software can be reviewed in the
“Device Manager” under “Devices”. This is a good place to confirm all portions of the
system are connected and working properly.

Devices Window  Applications Help

i:: TAPHEYES FITC-EYES TXRED-EYES MP-Home AlHome REMOVENDD DETECTORS RETURN TO CONFOCAL MODE

*On this system, you should see the
Nikon Ti Microscope and EPI light
source as being connected. If there
is a break in the chain i.g& , make
sure the device is physically turned
on, then highlight the device and

_ select “Connect” to reconnect.

25




Microscope Control

TiPad

Mosepiece
10x 40k o0x

Light Path

i i i St « The Ti Microscope Pad shows all

F e e . ' 4 B motorized components on the

Li0o @ rwo  Offset: § microscope that can be adjusted

owe « Note-your condenser and mag changer
syl (zoom) is manual and must match what
IS set on the microscope base to insure
proper calibration of images

Filters

Turretl

Condenser

3DICNZ

Configure...




LUTS and Histogram

LUTs =

2000 3000 4000

ra] =

4095

Edﬂﬂ 4&6“
LY

Hold Shift key to control all channels

I
1000 2000

The LUTs menu can be used
for brightness/contrast
adjustment (using triangular
sliders) as well as for
showing a saturation
indicator 4~ which can be
used to show what pixels are
saturated. Use the drop
down arrow to select
“complementary color”

The traditional Histogram
gives similar information
as the LUTs but is very
useful in determining a
confocal “offset”

adjustment
27



ND Experiments

HD Acguisition x

Experiment:  ND Acguisition

[¥] save to File
Path: C:'\Program Files\MIS-Elementsiimages),

Filename: nd00Z.nd2

DOrder of Experiment b

[ 4 i ¥ % 7 Series & Lambda

Setup

* o al

Oiptical Conf, Mame Comp. Color
[v] 405-483-561nm ~ DAPI

|= 540nm

=1
=

=) m—
agyi Run £ Corr

Browse...

Record Data...

Z Pos,

Advanced ==

6= Run now

*Experiments can be run on time,
Z-stacks, wavelength switching or
stage positions and image
stitching (if a motorized stage is
supplied).

-The next few slides will explain
each dimension.

28



Time Lapse

@ Eie - —  To add a timelapse, check off the
i —— checkbox for “Time”.

» Add a time phase by checking one
box; you can change the interval (how
often to image) and the duration (total
time). Alternatively you can input a
number of loops (# of images required).

l-**|

¥ | Close Active Shutter when Idie | Perform Time Measurement (0 ROIs)
J Use HW
seqUEncEr

= oIl ° Youcan add additional time phases to
be run in sequence.

J Use Ratio | Define Ratio. ..

* The “X” will reset the time phases.

29



XY-Stage Positions

|:|_ﬁ Time I_\_{_i u XY Pos __| = 7 Series i] & Lambda |__| P {arge Image

Points
+|Move Stage to Selected Point. & | ol @l ¢ 4

| ¥ [mm] 5
#2 7.939 1.793
#3 8.416 1.351

=

_|indudez  |Relativexy | Optimize | Load... | Save... |Custom...

v | Close active Shutter during Stage Movement

| Advanced Z:E:_

» To add XY positions, check off the
checkbox for “XY Pos”.

« Anytime you would like a position
to be remembered, check off a box.
This will add the XY coordinate as
well as Z (if checkbox for Include Z
is checked) or the PES offset

(if PFS is set). You do not need Z if
PFS offset it used.

*There is also a checkbox for “move
stage to selected point”, which will
allow you to freely move between
points by clicking on them in the XY
Pos box.

30



Z-Stacking/Optical Sectioning

Step: 1.157 jm [+ 0.981ym 8

Bottom: 2905.55 Hm Top: 2913.55 |Um

Step: 1.157 pm [~ 0.984m 9

Range: 8.00 pm <400, +4.00>

= ¥ 2|,

% Relative [ Home
Seee] 1157 | pm: = 0.981ym 9 |Steps

Below: —4.00 um Above: +4.00 Hm

f | | Use HW sequencer

There are three methods for optical sectioning....select one

1. Choose a middle plane and click “reset”, go to a live view
and focus towards the bottom (click bottom) then focus to
top (click top)

*Set your step size (distance between each plane) and/or
the # of steps you want (image total)

2. Choose a middle plane and click “home” then input a
distance range (equal from top to bottom)

3. Choose a plane somewhere in the sample and click
“*home” then input a staggered range above and below
31



Lambda-wavelength

HD Acguisition =

Experiment: MND Acguisition

[#] Save to File
Path: C:\Program Files\MIS-Elementsiimages),

Filename:  nd002Z.nd2

Order of Experiment -

[ % ¥ % 7 series ¥ & Lambda

Setup
& o al

Optical Conf. Mame Comp. Color

[+] 405-433-561nm - Pl

& 540nm

=1
=

= —
cgri Run £ Corr

Browse...

Record Data...

Advanced ==

Ge Run now

* You can add automated wavelength
switching to an experiment by checking
off the checkbox for “Lambda”.

*You can add an optical configuration, if
one was created, by clicking on the
down arrows

*Make sure to adjust your confocal scan
settings before adding

32



Image Stitching

* You can add image stitching to an
experiment by checking off the
checkbox for “Large Image”.

*You will need to make sureto run a
calibration before starting

@  Pattern i :Elrowse. v
Stitching:

v Place a high contrast slide

@ stitch Use [+ | for Stitching

@ Do Not Stitch on the Stage (llke an H&E) and
Overlap: 15 i% fOCUS |t

| Close active Shutter during Stage Movement

v" Locate Calibration =2?Recalibrate “x”
objective

v Select “Auto” for calibration

33



Confocal Imaging: C2+

34



Example Layou

[

i) ACQUIRE
E SCAN ZOOM
& Acquire Experiment

Caphis Compact GUI

B an

Loser S6L0mm 0.0

{2468, 2.264)mm, 2=22514um
A el
Y]




Using Optical Configurations

*You may have a series of shortcut buttons called “optical configurations”. Find them
under the OC Panel toolbar for imaging presets and control of the microscope with
a single button.

Click on the configquration you want to use......

On your system, click on:

405-488-561nm with TD (DIC): this will use all three lasers/PMTs as well as put in
the transmitted detector for taking a DIC image

640nm: this will use the 640 laser/PMT

Note: Please remove the transmission detector by clicking “EYEPORT” if returning to the
eyepieces to view a sample. The transmission detector is very sensitive to light and can be

damaged if fluorescence or transmitted light is used instead of confocal! 36



Confocal Acquisition: Quick Start

*The C2plus Simple GUI is a wizard that will
walk you through acquiring a confocal

> @ image

Scan Capture

C2plus Simple GUT =

1. Make sure you have previewed your slide through the eyepieces
and focused on an area of interest.

2. Select the objective that you're using in the microscope pad
Click on an optical configuration on the top toolbar to get started

4. Select what laser lines you want to acquire (check boxes for
DAPI/FITC/TXRED/TD (transmission) or CY5

. HV-Gain, start at 100

Ch.5etup [
rame Time: 11.7 sec £ Settings
— . Offset-background adjustment, start at O
30.0 pm . Laser Power, start at 5%
5 Start with a scan size of 512x512 and scan speed of 1.9usec.
6 Select “Normal” and “Ch Series”
[ 02 G s 00 7. Select 1.0 AU for Pinhole
8.  Start"SCAN’
9 Adjust if needed

Laser 488.0nm 0.0 10. Click “CAPTURE”

C.00

*To save, click on File>Save As and select either a .tif (keeping bit depth)
or .ip2 for raw data, NOT a JPG.
*To convert into a viewable image for photoshop,
save an additional copy as a converted tiff
(shown below)

File name: [Captured EH [ Save ]
Save astype: [Tagged Image Format (" tif: " tiff) B] [ Cancel ]
Comprsson:
TIF Compatibility Options
) Keep bit depth Save Color Image

) Scale 12 bit to 16 bit [ save Binary Image 37
(%) Scale 12 bit to & bit [T save Annotations

Convert multichannel images to RGE




The C2plus GUI-further explained (top to bottom)

1) Stops/Starts Live Image Acquisition (as a default, please do not use any averaging or

integrating in this mode, see #9) Caplus Simple GUT x
2) Capture: captures an image (using user defined settings below) P~
3) “Find Mode”: Implements a fast preview scan

a) Defined by Find Mode Settings in & Setﬁng5v|

Find mode settings [

¥ Change to band scan with aspect:
@& 4 (e

[ Lower resolution:
= A (B

[V Line skipping:
& a4 8x

[V Turn OFF line&frame averaging

[ Change Galvana to Resanant

== == —

4) Eye Port-changes to last used non-confocal setting, click again to return to confocal
mode (N/A on this microscope)

5) AG: Auto Gain feature; sets the HV (gain) for optimum based on user settings (for more
info see Help Menu, 4.2.5 in software)

6) Unidirectional/Bidirectional: scan direction (Uni-one direction, traditional scanning; Bi- E e Laser 498.0m 0.0
directional, used for live imaging for speed increase—does need to be aligned during 74
scan). See Help, 8.1.3 for more info.

7 Pixel Dwell/Frame per Sec: scan speed; pixel dwell in micro seconds
8) Size: Scan Size in XY

9) Averaging @ and Integrating z . average signal by line or integrate signal by line
(see Help, 8.1.4). Normal mode does not use either. Typically averaging is used only for
image capture, not for live preview.

10) Ch Series: Channel Series; setup will allow for each laser to be run sequentially rather
than simultaneously *important for closely excited fluorophores! See Help, 4.1.4

11) Pinhole: adjusts size of pinhole, 1.0 AU can be set via button as standard, see Help 4.2.3
for more information.

12) Optical Path Settings: to set up lasers, dichroics, filters; for experienced users only!

13) Laser Selections: check off laser lines to be used. HV is your amplification gain (100 is a
good starting point), offset will black values (0 is a good starting point) and the
wavelength shown last is your laser power in % (5 is a good starting point).

Note: Offset Adjustment

Offset values should be close to a number value of 0 (zero) but a histogram should be
previewed to adjust this value accurately. The left side of each wavelength’s peak should be
close to 0,0 (bottom left of histogram). A more positive # will move the peak to the right, a
more negative # will move it to the left. Please ask for assistance if you need help—this step is
VERY important!




Scan Area/Zoom/
Resolution Improvements

» Locate the “C2 Scan Area”
dialog (View—->Acquisition
Controls—>C2 Scan Area)

* You can click and drag the
green borders of the image to
zoom into an area of interest.
While zooming in normally
decreases resolution, it can
increase resolution when using a
A Scanven confocal. The pixel size will

e decrease and keep the image
size the same.

*The “Nyquist XY” button will
select the appropriate settings to
set the selected area at Nyquist
resolution (based on preferences
set with drop down arrow).

39



Notes on Proper Confocal DIC

Caplus Compact GUI To get DIC, you must:

1. Make sure the TD is in the light path

2. Make sure the polarizer is in the light path on the
microscope. This must be rotated depending on
sample. Shading will change with rotation. This
means your HV (gain) for the TD will also need
to change (increase or decrease with angle of
the polarizer).

3. Make sure you are using the correct condenser
prism with the correct objective.

Condenser Prisms-

manually controlled by hand
40

*REMEMBER: DIC ONLY WORKS WITH GLASSI!! NO PLASTIC**



Brightfield Imaging: Nikon Fi2

41



To use brightfield for

color camera:

S DISPLAY

O & Z-RESET
I

Condenser Prisms-

manually controlled by hand

1. Place your sample on the stage and
choose an objective

On the right panel, rotate “FL Block” to
“DIA or empty” (for diascopic/brightfield) or
ANALY (for analyzer-for DIC)

Select a condenser prism; A (brightfield),
PH1 (for 10x Plan Fluor only),DIC N1 or
N2 for DIC if applicable (selectable by
hand)

Turn on the diascopic light from the left
side of microscope and adjust the light as
needed

Select “R100” from front panel

On/Off for
transmitted light
(brightfield)

Rheostat for
transmitted light

*Note: to use a contrast method, you must match your condenser
prism to the appropriate objective; each objective will have
writing on the side to denote the condenser prism to be used
i.e.“20x, DIC N2”



Imaagin

Mode

Resolution

Fast (Focus)
Quality (Capture)

|800x600

'800x600 - Sbit
High Quality Capture

Nikon Fi12 (U3) Color
Camera

/Keep on Normal for Brightfield Imaging
Mormal | Binning | i — i i

Resolution for Fast=what is used for live preview
(useful for faster focusing, stage movements)

_ Resolution for Quality=what is used for actual
capture

Push Auto Exposure to constantly auto expose,

Exposure
Auto Exposure | [ 57 ms - | € depress for manual control of exposure time and
gains used
Analog Gain 1 ¥ [ 1.0x
AE Compensation +0.3EV L,_< AE Compensation for increasing/decreasing image
brightness
Color
Ado white € Auto White must be used in an area with ONLY
Scene Mode BACKGROUND (no sample) before any images are
For Neutral I acquired! Suvs ;;ag;ggg;v
| ! » . ‘._- !g‘tm /
Proper White Balance % _.I_(_“:T,;- ey ,Ti:‘: Bad White Balance
Scene Mode < ] [ Commands ¥ ] il 4

Scene Mode has auto-presets for different imaging
conditions 43



Post Acquisition
Image Adjustments

44



Scale Bars

A Scale Bar can be added at any
time from the right side image
window’s toolbar. Once positioned
where you choose, you can right
click on it to change its properties
or to “burn it” into the image

*it is recommended to save an
original image before burning a
scalebar into an image, save the
second as a copy

A TRED WID  03lum/x | 22w 512x5i2pels | WAL

45



How you can V|suaI|ze your data.......

PrOjectlon

46

*Can also make really nice 3D rotational movies as .avi’'s!



Movie Maker

Click the film icon to open movie maker

View -

DAnkasQECUUG.ndZ - Volume
Ly W X B -]~ @ == B8 17 Ve EOFe ¥ - | & |
Z-zoom ~ | Blending: Max ~ | =] 'HT’J_— :@Bcunding box {on bottom) ~ § "_| ',z o oF |

Make rotations/movements/adjustments
and click where you want them to show
up in the filmstrip. Once you play it
back and it looks good, click on the film
icon to create an .avi.

| &t & & 4

%
ks

SERCEAIIEELIE

File name: |AnkasQ2C 006 j Save |
Save as type: |A\.f| Image File Format (*.avi) ﬂ Cancel |
[™ Use Default Video Compression 0 com preSS|0n
|N0 compression / -
Qutput Timing Parameters Experiment Loop
" Use Original Acg.Time e

¢ Use Z-stack Loop

( Spedfy interval: | 200 ms ¢ Usa Z-stack and Time Loop

0:30  0:40  0:50 100 L:10 1:30 1:30 ﬂ 1:50  2:00 2:10  2:20  2:30
ol 1 alinonlicnndion TETH PO TR TR vl

. About 150-200ms

.~

Z¥|

—

'\ All/BDAPL; LFITC / [2¢17bit: 102 ixels

is usually good
47

Click film strip (black to red) to go into editing mode



=uE

EJEI “R] ] - I E R

" X” Key Snapshots

=E

B e e g *Jse the “x” key on your

| keyboard to take snapshots
| for publication/presentation

=1
| 3R

& 37 = -can be used on any open
= | RGR 8hit 1079 x 367 pixels {N.‘"F.]- . | image WindOW’ in any

¢ @+ 00

“Split Window”

A
T

|
A -
., =
.
!_' 5

48
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“Shift then Z” Full Resolution
Snhapshots

*Use the “shift then Z” keys
on your keyboard to take
full resolution snapshots for
publication/presentation

-zoom must be set to 100%
before setting snapshot

Keeps original 49
resolution or higher!



Magnifying Glass

0B NS Elements AR ~ [View s

Acquire € ation e Binary Measure Reference Macre  View Devices Window Applications Help ° The magnifying gIaSS Can

on Image Binary M R
SEY © 0@ @ @bA L 0% 7| DAPLEYES FITCEVES TXREDEYES MP-Home A
X

T — == pe used to show zoomed
SR SRR SR portions of an image

« Under View->Magnifying
glass options, you can change
| the zoom and shape/border

*Holding down “shift” after
choosing an area can allow it
to be moved to another spot
on the image; click on “X” to
take a snapshot (as shown
here)

I‘ System Information x £ o
% RGB / Red M Green Blue

+ 0,12 pmifp RGE Sbit: 533 x 533 pinels

50



Image Saving Helper....

Yay, | just captured an Image!!

Do | want to use my image . | don’t have time to mess with

for analysis? Do | want to use my image many adjustments, | just

e S for publication? Or open want to send the image

Cell Counts H A olleague or open |

in later in PhotoShop? 0 acofieag oP
on my own computer without hassle
| need to convert my captured image to 8bits/channel, If | want to, | can adjust my brightness and contrast within Elements:
| can do this in Elements by: -
- View->Visualization Controls>LUTS
I need tO Save my Image Image=>Convert>Convert to 8bit RGB (drag bounding bars to make darker/brighter)
as either a .TIF or .JP2 Now 1 can save my image as i and clekon e keyon your esonr o ke compress,
will open up in color for publication or adjustment
in photoshop Save new copy as a .tif

51
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